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1.1 USER MANUAL 1

User Manual

WIRED 4 User Manual

This manual explains how to use WIRED 4 and its associated plugin modules inside JAS 3. It covers
subjects ranging from installation and setup through data access to interactivity and producing output
plots. Experiment specific notes are written up in appendices.
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1.2 INTRODUCTION 2

Introduction

Introduction

WIRED [1] is an event display system which allows users to visualize single event data on any platform
using JAS 3 (Java Analysis Studio). Events can be browsed by WIRED from any source that can provide
data in the HepRep standard [2] . Data can be particle physics events, detector geometries, or any other
hierarchical graphics information. HepRep data can be supplied to WIRED in XML format from files,
converted from some other format on the fly, or by using communication mechanisms such as CORBA
or RMIL

WIRED 4 is an experiment independent plugin module for JAS 3. It is written in pure Java and runs on
any platform that runs Java and JAS 3 [3] . These platforms include the whole range of Windows
operating systems (95, 98, ME, 2000, NT and XP), MacOS X, Linux and other Unix systems. WIRED 4
handles data in the HepRep standard. To supply WIRED 4 with the necessary HepRep you need other
plugin modules, some of which may be experiment specific. To handle HepRep XML files you need to
install the HepRep plugin, see installation . See the appendix for your experiment (BaBar, GLAST, Linear
Collider, Geant4) to see what plugins to load into JAS.

The WIRED 4 system takes HepRep data, runs it through some projection and displays it on the screen.
The following features are currently available in WIRED 4:

* Data Access
* Access HepRep 2 data.
* Access HepRep 1 data via converter.
* Browse multiple events in XML format in either plain files, zip files or gzipped files.
* Interactivity
* Selection of multiple euclidian and non-euclidian projections: Parallel, FishEye, RhoZ, etc.
* Interactive scaling, translation and rotation, including feedback.
* Interactive changes to settings such as projectsions, global variables, etc...

* Advanced picking of pre-selected objects and showing physics (and non-physics) information
from the HepRep data.

* 3D translations using picking, for instance to select a calorimeter hit and center it for rotation.
* Tree representation of HepRep data to control the detector and or event visibility.
* Almost all interactive commands can be undone and redone.
* Output
* Layering of Hits on Tracks on Geometry, making all visible at any time.
* Change of quality settings for both display and file output.
* Low quality output in bitmap graphics formats, such as PNG and GIF.
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1.2 INTRODUCTION

* High quality output in vector graphics formats, such as PostScript, PDF, EMF, SVG,
Macromedia Flash and others.

* Copy on the Windows platform to the clipboard (in EMF format) for pasting in PowerPoint or
Word.

Among the features on the list for post version 4.0 are:

L]

Interactive cuts on physics (and non physics) information, so users can for instance hide all tracks
below a certain energy.

Scripting to allow users to run small programs to manipulate the HepRep data.
Labeling of objects on the screen.

Interactive 3D translations using orthogonal views.

Full implementation to save the state of the application.

Use of the plugin to create histograms in JAS 3.

Other user requests.
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1.3 INSTALLATION 4

Installation

Installation of JAS 3 and WIRED 4

Users are encouraged to install JAS 3 and WIRED 4 on their local machines. This has the advantage that
the local CPU and memory is used for running these programs and no usage is made of remote
XWindows in the case of Unix.

Before you can install WIRED 4 you need to have JAS 3 installed. You need at least version 0.8.1 of JAS
3. If JAS 3 is not yet installed, do so now, by following the instructions from the JAS 3 website at:

http:/ /jas.freehep.org/jas3/index.html .
To verify the version number of JAS 3 select Help->About from the menu.

To run WIRED 4 you need at least the following three plugin modules:

1. WIRED 4
2. WIRED 4 Base Library
3. HepRep

Launch JAS 3 and select View->Plugin Manager from the menu. On the Installed tab you may find
WIRED 4 listed under either system or user. If this is the case, WIRED 4 is already installed, but you
still may want to upgrade to the latest version.

If you do not find WIRED 4 here, go to the Available tab (you need to be connected to the internet at
this time) and look under hep/visualization. You should find WIRED 4 here. You need to install both
the WIRED 4 Base Library and WIRED 4, by selecting the first one with a click and the second one
with a shift-click. Then select either to install them in the User extensions directory or in the System
extensions directory, it does not matter, but you may not have write permission in the System area.
Once selected, click Install selected plugins, which will download the plugins and install them. Progress
will be shown. You may check that WIRED 4 is installed, as it should appear now under the Installed
tab.
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1.3 INSTALLATION 6

To view HepRep data you also need to install the HepRep plugin. You need at least version 1.3 of this
plugin. Again you can check if the HepRep plugin is installed by looking under the Installed tab. If not,
it should be under the Available tab under hep/visualization.

Any plugin can be updated if newer versions are available, and plugins can also be removed.

To get tid of the plugin manager, push the Close button.

The following plugin modules are part of or related to WIRED 4:

WIRED 4: The main WIRED Event Display plugin.

WIRED 4 Base Library: The base library for WIRED 4, which is also used by other graphics
visualization plugins such as the FITS plugin.

HepRep: The HepRep2 XML file reader, the HepRep1 to HepRep2 converter and the HepRep1 and
HepRep2 interface standards.

WIRED CORBA HepRep Client Plugin: The CORBA client which connects to HepEventServers
[4] to retrieve HepRepl or HepRep2 data using CORBA. This client can also handle JProcMan [5]
lookups. This plugin is useful for GLAST and BaBar.

WIRED 3 Graphics Format: A converter plugin from the WIRED3 graphics format to HepRep2.
This plugin is only useful for BaBar, where the geometry description in in WIRED3 Graphics
Format. The geometry of BaBar is included in this plugin, so the plugin is rather large.
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1.4 JAS 3 7

JAS 3

JAS 3 provides an Analysis Studio for the user. It is based on the FreeHEP Java Library [0] . It handles
installation and interaction of plugin modules. Different plugin modules can be loaded into JAS 3 to do
analysis on multiple events and view histograms, or to browse datasets and view events one by one using
WIRED 4. JAS 3 comes with a set of default plugin modules installed. You have already installed the
extra WIRED 4 and HepRep plugin modules, so you should be ready to browse and view events.

To get started, you may download some sample HepRep files from the WIRED 4 HepRep download
area and store them on some accessible area. The HepRep examples can be found at:

http://wired4.freehep.org/heprep/examples .

HepRep files can be opened in JAS by selecting Open DataSource... from the File menu. This will open
the DataSource wizard and allow you to select from a set of HepRep (and non-HepRep datasources).
You should be able to select HepRep XML, and if you installed the WIRED CORBA HepRep Client
Plugin you can also select events from CORBA servers.

x

Select dala SO bpe

it Fiba | 100t)

Note: If this option is not available, the HepRep plugin is not installed. Open the Plugin Manager and try
to see what went wrong,

Select Next in the wizard and browse to one of the downloaded HepRep files and open it. The toolbar
now expands by showing you the current dataset and a set of buttons to browse through the event set.
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The dataset is now open, and you are situated just before the first event. To navigate through your event
set you have the following four buttons available:

. 44 Rewind to the start of the dataset and set the pointer just before the first event.
. |} Run through all events (not useful for Event Display).

. D[’ Go to next event.

. Stop processing (only available while loading a next event).

You may also select any of these options and more from the Run menu.

You could navigate to the first event now, but it would not show since you have not yet opened any
WIRED view. To open a WIRED view, select New->Wired4 View from the File menu. If you click on
Next event ﬂ[’ now, then the first event of your dataset will show. The next picture show the first event

out of the A01 Geant4 example dataset.
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1.5 ENVIRONMENT 9

Environment

The JAS 3 and WIRED 4 environment

Before we go on and explore events, let us look at the JAS3 and WIRED 4 environment. As JAS 3is a
plugin based system, menus, toolbars and windows can be added by different plugins as they are installed,
loaded and started. Your JAS 3 may thus look a little different than the one shown here.
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At the top we have a menubar, where we see the standard set of menus. We can also see that the LCIO
plugin has added its own menu. Unless you are working with LCIO you probably will not have this
menu. Just below the menubar we find the toolbar. If we have a dataset open, it will show this dataset by
name. If the dataset is browsable there will be a set of buttons to browse it. If you have executed
commands which can be undone/redone a small toolbar will be available to undo the command. If you
are looking at an event, you will also have buttons to Copy and Save As. Somewhere on the toolbar there
will be buttons for interaction with JAS. These buttons will be explained later on. The toolbar buttons
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1.5 ENVIRONMENT 10

will be enabled or disabled depending on the availability of certain functions. Tooltips will show what
each button is useful for.

The rest of the main window is split into two panels. On the right, the views, which are tabbed, so you
can switch from one to the other, or to panels with output from other plugins such as histograms. On the
left, the tabbed control panel, where you can find the main tree with DataSets, Histograms and the
WIRED 4 control panel. This control panel is used to show extra information and let the user choose
more advanced functionality.

All the way at the bottom-left is the status bar, which shows messages to inform the user what has
happened, or what the next step is he can perform. At the bottom right is the progress bar, to show what
JAS is doing and the memory usage.
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Commands

Commands

Most commands are available from the menus, the toolbar and from the popup-menu. The popup menu
is specific to the view and can be popped up with a right-click on the mouse. On the Macintosh ctrl-click
will show the menu.

Most of the commands that change the view can be undone. Once undone, the command can again be
redone. A whole sequence of commands can be undone one after another. The sequence is broken if a
command is executed which cannot be undone. Then, unfortunately, there is no further way back. The
tooltip on the undo/redo button will show the next command it will undo/redo and the status bar will
also show information about the command.

Undo / Redo functionality is available from the Edit menu and from the toolbar:

. @ Undo
. @ Redo
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Data Access

Accessing Data using the HepRep plugin

The backbone of WIRED 4 is the HepRep2 standard. In principle this is the only "format" that WIRED
4 accepts. However, additional plugin modules make HepRep1 and older formats also available to
WIRED 4. If you were to write a plugin module to make your data accessible in HepRep format,
HepRep2 would be the better choice.

The HepRep2 format stores information such as points in a tree structure. Special drawing attributes are
attached to the tree to show how to represent the points (as symbols, as lines, as polygons, cylinders, etc).
With this information WIRED 4 can do a projection and make a drawing on the screen. Additional
information of any type, including physics attributes, can be attached. This information can be shown on
the screen in picking mode, or be used in future for cuts.

File Access

HepRep2 data can be read from files, either in the form of XML HepRep (heprep) or in the form of
Binary HepRep (bheprep). XML files tend to be fairly large while Binary HepRep files are quite a bit
smaller and faster to parse. Both XML HepRep and Binary HepRep files can be compressed using gzip
format (.gz extension). However, to allow multiple events to be stored in one file, HepRep2 uses the zip
format (.zip extension), which allows semi-random access to the events and compression at the same
time. The HepRep plugin handles all these different file combinations.

HepRepl files can also be read. The same applies for compression and multi-event handling as for
HepRep2, but no Binary HepRep exists for HepRepl. HepRep1 data, once read in, is converted on the
fly to HepRep2 data.

HepRep files can be opened by selecting Open Data Source... from the File menu and selecting the
HepRep XML wizard.

CORBA Access

HepRep data can also be accessed using the WIRED CORBA HepRep Client Plugin. This plugin is a
client of the HepEventServer and JProcMan systems and needs to be separately installed.

HepRep CORBA connections can be created by selecting Open Data Source... from the File menu and
selecting the HepRep CORBA Servers wizard. Appendix A: BaBar and Appendix B: GLAST explain
how to select data from a CORBA server.
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1.8 PROJECTIONS 13

Projections

Projections

To show HepRep data WIRED 4 uses projections to make that data visible on the screen. One can use a
single projection or concatenate projections together to form new composite projections. A set of
standard projections is available. New views are currently created with a Parallel projection. The
projection can be changed from the popup menu.

Parallel

A Parallel projection transforms 3D space onto 2D space, which can be subsequently used for viewing.
This projection allows the user to Scale, Translate and Rotate the HepRep data to any point of view.
Parallel projections can be created with any of the following initial viewpoints: XY, ZX, ZY, XZ and YZ.
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1.8 PROJECTIONS 14

Flat

The Flat projection does the same as the Parallel projection, with the exception that Rotation is only
possible in the Z-plane. This projection is normally used to Scale and Translate the result of other
projections which have no more depth (Z) value, such as the YX-FishEye or the RhoZ projections.

YX-FishEye

The YX-FishEye projection looks at the 3D space in the form of a fish eye. The inner parts are blown
up, while the outer parts are squeezed. The projection leaves straight tracks through the center straight,
but it does deform the curved tracks. The idea behind this projection is to show detail of the inner
detectors while not loosing the context of the outer detectors. This projection works well for YX-cuts of
cylindrical detectors. The Settings control panel allows you to modify parameters of this projection to
change the distortion factor.
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Rhoz

The RhoZ projection cuts a detector into two halves along the Z-axis and projects either half onto the
screen. The idea behind this projection is that it is strictly orthogonal with the YX-projection. A YZ or
XZ projection would be orthogonal as well, but tracks coming out of the screen would not be visible.
This projection works well for the "side view" of cylindrical detectors. The Settings control panel allows
you to modify parameters of this projection to change the cutting angle or to not cut the detector at all.
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RhoZ-FishEye

17

This projection is a composition of a RhoZ and a FishEye. The detector is cut into two halves along the
Z-axis, projected onto two halves of the screen, then the center is blown up, while outer parts are
squeezed using a rectangular fish eye projection.
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Interactivity

Interactivity

In general the available interactive functionality depends on the chosen projection and type of data being
viewed. Most projections provide Scaling and Translation.

If you have a mouse with a mousewheel it will zoom in or out. Scroll down will bring the picture closer to
you while scroll up will push it away.

Some interactivity can be achieved by direct actions, other functionality depends on the interactivity
mode being used. Only one mode can be active at a time. This mode is shown by the button being
selected from the toolbar, the control panel being shown and the cursor shape while moving the mouse
over the view.

Direct Actions

Direct actions will result in an immediate change.

_ Reset
000
[

Reset is a direct action. It will put the view back into its original state of the projection.

#M Fit to Window
il W =
1

Fit to Window is a direct action. It will measure the bounding box of the event/geometry in its currently
visible state and will Scale and Translate to fit it within the boundaries of the window. The Scaling is
uniform. The Translation will center the result.

Interactivity Modes

Of the modes described below only one can be active at a time. The active mode is shown by the
corresponding button being depressed, the corresponding menu item in the popup menu being flagged,
the corresponding control panel being shown. Any mouse interaction started may be interrupted by
pressing the Esc key.

Q Scaling

Scaling will allow you to enlarge or shrink the picture you are currently seeing. You can also zoom into a
region on the screen. When you select the Scaling mode, the control panel will show you a choice of
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1.9 INTERACTIVITY 20

three sub-modes in its Selection box:

. rq The direct scaling mode scales along the center of the screen. When you drag the left-mouse

button in the view towards the center the image will shrink, while when you drag it outwards it will
enlarge. Feedback is shown in the form of a circle around the center. This is also the mode which is
continuously connected to the mousewheel and works even if another interaction mode is active.

If you click the mousebutton the view will be scaled up by some standard amount. If you alt-click the
mousebutton the scaled down by some standard amount.

. D\' The rectangle scaling mode allows you to zoom into a rectangle. When you drag the

left-mouse button a fixed ratio rectangle will appear. When released this rectangle will be centered
(Translated) and enlarged to fill the view. The view will not be distorted. If, while dragging, you press
the shift key, you can select an arbitrary sized rectangle. When released this will be centered and fill
the view, however, now the result will be scaled non-uniformly to fill the view.

If you click the mousebutton, the position of the click will be centered and scaled up by some
standard amount. Alt-click will produce the opposite result.

. r@ The rotated rectangle scaling mode allows you to zoom into a rotated rectangle. This mode is

NV

useful for zooming into tracks at arbitrary angles. When you drag the left-mouse button you will see a
line appearing. Drag the line along the track. Now release. You will see a straight or skewed rectangle,
along the line just drawn. The ration is fixed, however you have the choice between a straight
rectangle, a X-skewed or a Y-skewed rectangle. Click to select one of the three. The picture will now
center, rotate, de-skew (if necessary) and scale to fit the view. Deformation of the picture will happen,
if you de-skew.

While selecting the final rectangle you may either press the shift key to remove the ratio constraint
(the result will deform while scaling) or the ctrl key to remove both ratio constraint and angle (the
result will most likely deform, but you can select an arbitrary parallelogram.

If you click (before dragging) allows you to define the rotated rectangle by selecting three points (start
center line - end center line - corner point).

{ Translation

Translation allows you to move the picture anywhere inside the view. Translation (apart from incurred by
any of the scaling modes) will only work in direct mode. The control panel will give you no other choice.

When you drag the left-mouse button the picture underneath will follow until you release the mouse
button. If you click, the clicked point will be centered. If you alt-click the center will move to the clicked
point.

Translations like these will only have an affect on the currently viewed angle. So, if you click on a
calorimeter cluster, the cluster will move to the center of the screen, however if you go on to rotate the
cluster, you will find that the model is not centered along the screen's Z-axis. In fact what will most likely
happen is that the model will float out of the viewable area while you rotate. To select a proper rotation
point a 3D translation mode will be added in the near future.
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@ Rotation

The rotation modes are both immediate. From the Selection box you may choose between:

. rﬁ Rotate in the screen's Z-plane. When you drag the left-mouse button the picture will rotate
L I i

over the center of the view. Clicking has no function.

o @ Rotate in 3D using a virtual ball. When you drag the left-mouse button the picture will rotate

as if captured by a ball which you roll to any side. Although it is possible by small circular movements
to rotate the pictute in the screen's Z-plane, the option above is easier. By holding down the shift key
while dragging rotation will be limited to the screen's Y-axis, while the ctrl key will limit rotation to
the screen's X-axis. Clicking has no function.

f Picking
Uk

Picking allows the user to show information attached to the objects shown in the view. This attributes
can be physics values or other relevant information. When you select the picking mode the control panel
will allow you to select from different sub-modes:

. f Direct picking of the object nearest to the mouse. As you hover the mouse over the view, an
l_‘.

arrow will appear from the furthest corner, pointing to the object nearest to the cursor. A circle is
drawn around the object, with a radius large enough to include the cursor. As you move the mouse,
the arrow may move to nearer objects. If you click, the position gets fixed, the circle disappears, until
you click again to release the point. The selected object is shown in the control panel, see below.
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. D Selecting all objects within a rectangular shape. In this mode you need to drag the left-mouse

button to create a rectangle, which surrounds the objects you would like to pick. When you release,
the objects inside the rectangle will be selected. The non-selected objects will dim their colors to gray,
so that the selected objects highlight. If objects, such as tracks, extend outside the rectangle
boundaries, they will also highlight there. In the control panel you may now select the action Zoom
into region to center and scale the view to only show the selected objects.
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The control panel will show a table of picked objects, which update as you change your pick of the view.
If only a single object is picked, its attributes will show in the attributes table. If multiple objects atre
picked, then you can select one object from the picked table to show its attributes. Doing so will cause
the view to only highlight that single picked object.

The Options... button in the Picked objects table allows you to restrict the picking to certain layers and
to certain HepRepTypes. The layers are shown in a list, with a checkbox if this layer is used in the
picking. The HepRepTypes are shown in a tree, where checkboxes mark if types are used in picking.

The Options... button in the Attributes of picked object table allow you to limit the display of
attributes to certain categories. The categories are shown in a list, with a checkbox if attributes of a
category are shown.

Bt

In tree selection mode, the control panel shows a tree of HepRepTypes. If you expand the tree you will

= Tree Selection

find familiar names of your event and geometry. You can toggle the visibility of certain object types, by
clicking on the right-most checkbox. The left most checkbox only exist if the object in the tree is a folder.
It shows three states:

* Off, when all sub folders and sub nodes are invisible, or when this folder was made invisible by the
user.

* Checked in gray, when some of the sub folders and sub nodes are visible.

¢ Checked in white, when all of the sub folders and sub nodes are visible.
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This checkbox may change state depending on the state of other checkboxes. By clicking, it will either
switch off or checked (in one of the two conditions depending on the sub-nodes). It allows you to hide
whole subtrees at once.

The tree also has a popup menu to allow you to execute actions such as "Expand all", "Collapse all",
"Show all", "Hide all" and "Invert All" for the node you clicked on when selecting the popup menu AND
all nodes below that one.
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Below the tree there are several other options available:

* By switching off the Apply immediately checkbox the user can make changes in the tree without
applying them until he pushes the Apply button.

* By switching on the Hide below level checkbox the user can ignore certain depth of the tree, set by
the level number. The result is reflected immediately in the tree, by dimming out useless checkboxes.
The view will react immediately if Apply immediately is checked.

The tree is associated to the selected view.

g Settings

The Settings panel allows you to change and control general settings and settings of the projection(s).
Any variable may be selected from the table. For numeric variables a slider appears and a value box. You
may use either to make changes to the variable. Variables can be coupled so that their maximum and
minimum value may depend on another variable, or a vatiable may only be active after switching on a
different variable.

©1996-2005 WIRED - FREEHEP « ALL RIGHTS RESERVED




1.9 INTERACTIVITY 25

3, teternction || f chirg s Settreg |
et apha
mare | wie | wea | =
Lalgiha T.A 4000 -4
el I F | =
by el ] =]
L setted et (=] =237
e =
o' hish i AT -
o kebhdh =)
Fadebs e :: =00
] F |
ETEH T 3
—2E000
= S
=J22E000
= 203005
= 200000
- R
=
"'J-nm:u
IR ]
o e
——
T el

Quality Settings

The quality settings allow the user to make the picture show better on the screen. The default settings are
the best for performance, but for screen, printer and file output it may be worthwhile to switch some of
these options on.

r Draw Thick lines
--'ﬂ

This option will draw lines in the thickness given by the HepRep data. Especially for online presentations
this may give better viewable results. When this option is off, the lines are drawn in single unit width,
which gives the best interactive performance.

E Fill Boxes

This option will fill symbols (hits) and some polygons (calorimeter hits) when the fill flag is switched on
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the HepRep data. When this option is off, all filled objects are drawn only by a surrounding line, which
gives the best interactive performance.

E Draw Frames
| |

To show colored objects (hits) on top of other colored objects (tracks) it is sometimes useful to draw a
thin (black) frame around them. This option will draw such a frame if the HepRep data contains
information for it. The loss in performance can be dramatic, as the number of drawn objects multiplies
by two and all frames are filled objects.

ﬁ Anti-Alias
T

To smoothen curved lines and lines with non-trivial angles, you can switch on anti-aliasing, which blends
the jagged edges due to pixelation into the background by choosing mid-tones between the line color and
the background color. As this is a pixel-by-pixel operation it can be quite a performance loss. Future
versions of Java may use hardware acceleration if available.

Use Layering

All objects are drawn in layers: hits on top of tracks on top of calorimeter hits on top of geometry. The
layering may cause certain objects to disappear, when data has not been correctly layered. If you switch
off layering these hidden objects may suddenly appeat. There is no performance loss for having layering
switched on.
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Output

You can use the plots you have created in other documents or programs. To do so you can use either the
Copy-Paste or the Save As functionality built into JAS 3 and WIRED 4. You can use these two buttons
on the toolbat:

. |E Copy
. Save As...

and printing from the menu:
. ‘JE;' Print

Copy - Paste

This method is recommended on Windows platforms, since it uses the Windows Enhanced Metafile
Format (EMF) internally, which will not work on other platforms. On other platforms copy-paste will
copy a bitmap graphics, rather than a vector graphics, so use save as instead.

On Windows select Copy from the Edit menu. You may now paste the clipboard contents into
programs such as PowerPoint and Word.

Note: The EMF format is supported on Windows N'T/2000/ME/XP only. Earlier versions of Windows
(95/98) have immature versions of EMF which may even destabilize your system.

Save as Vector Graphics or Bitmap formats

You can also save your output in a variety of formats. Select Save As... from the File menu and a dialog
will pop up. You can select an output filename, a format and then click on Ok to export the file. The
Options... button, when available, lets you change options specific for each graphics format.
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The following formats are Vector Graphics formats. They can be resized without losing information.

28

* CGM: Computer Graphics Metafile, not very much in use, but can be read by PowerPoint and Word.

* EMF: Windows Enhanced Metafile Format, can be imported into Microsoft products (PowerPoint,

Word...).

* EPS and PS: Encapsulated PostScript and PostScript, for usage with LaTeX and FrameMaker.
PostScript supports multiple pages.

* PDF: Portable Document Format, for electronic distribution, supports multiple pages.

* SVG: Scalable Vector Graphics, for usage with viewer on the World-Wide Web.

* SWF: Macromedia Flash File Format, for usage with viewer on the World-Wide Web. Can be used in

animations.

The following bitmap formats are available by default in Java. Bitmap formats can be resized, but this
results most of the time in a loss of information.

* GIF: Graphics Interchange Format, bitmap format of the World-Wide Web, limited to 256 colors.

* JPG: Joint Photographers Expert Group format, useful for photographs and not much for line
drawings.

* PNG: Portable Network Graphics, replacement bitmap format for GIF. No limitations on the colors.

* RAW: If you really want big files without compression. For conversion to something else...

* PPM: UNIX Portable PixMap format, for usage with the NetPBM package to convert to other
formats. Output fairly big.

If you also have the Java Advanced Imaging library installed you may also exportt to the following
bitmap formats:

* BMP, WBMP: Windows Bitmap Format, for usage with some Windows tools.

On top of these output formats you can save the HepRep data in HepRep2 XML format. You cannot
save into HepRep1 XML format, since there is currently no converter to convert HepRep2 back into
HepRepl.
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Printing

Views can be printed using the JAS 3 print functionality. The following options are available from the
File menu:

. ‘J:_‘EH Print Setup... - will allow you to setup the printer.
¥
. E' Print - will print the view to the default printer (setup under Print Setup...)

. Print Preview - will show you what the printout will look like and print is subsequently.
Ll
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1.11 COMPARISON TO WIRED 3 1

Comparison to WIRED 3

Comparison to WIRED 3

A lot of the features of WIRED 3 [7] have been augmented in WIRED 4. Below a comprehensive list of
the main differences:

WIRED 4 runs as a plugin in JAS 3 as opposed to WIRED 3 which runs as a stand-alone program.
This has the advantage that a lot of the base functionality of JAS 3, most of which is part of the
FreeHEP libary, comes for free. Such features include: output to graphics formats, copy-and-paste,
setting of preferences, services and plugin modules, automatic updates of modules, etc.

Integration in JAS 3 also means that some functionality sits deeper in JAS than in WIRED. For
instance, access to data is arranged using a standard record loop, datasets can be opened using
wizards, etc.

The interactivity modes of WIRED 4 give better feedback and are more useful to the user than the
ones in WIRED 3. All the interactivity modes of WIRED 3, direct zoom, direct translation and direct
rotation are all available in WIRED 4. On top of these modes, you can now select a region and zoom
into that region. You can also easily select regions along a track and zoom into those.

The picking mode of WIRED 4 shows information in an easier way than WIRED 3. The latter would
pop up boxes all over the screen, while WIRED 4 places information neatly in a control panel on the
side. The interaction in WIRED 4 works both ways. You pick in the view and it shows in the control
panel, or you select in the control panel and it highlights in the view. WIRED 3 does not have this
capability.

WIRED 4 is extensible: new projections, representations and scripts can be created and added to
WIRED 4. These features and how to write your own extension modules will be documented in the
JAS 3/WIRED 4 developers manual, which is cutrrently being written.

WIRED 4 uses HepRep 2 as its base format but can handle HepRep 1 using a converter plugin.

WIRED 4 contains far fewer classes than WIRED 3. This makes WIRED 4 more maintainable,
which reflects in a a quicker response to user requests and bug fixes.

There are a few features not included in this first release of WIRED 4:

The tree only shows HepRepTypes and not HepReplnstances.
Cuts as implemented in the latest version of WIRED 3 are not yet available.
There is no way to show labels in this version.

The state of the application is only partially saved.

But, we are working on it...

©1996-2005 WIRED - FREEHEP « ALL RIGHTS RESERVED



1.12 FEEDBACK 2

112 Feedback

FeedBack

Your feedback is very useful and welcome. If you have problems using WIRED 4 or think of good ways
to extend its functionality, please use our discussion forum at:

http://forum.freechep.org/

WIRED 4 keeps a database of bugs, issues and further improvements, which can be found at:
http://bugs.frechep.org/

WIRED 4 is OpenSource, so please feel free to download the source code from:

http:/ /wired4.frechep.otg/SourceDistributions.html
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1.13 APPENDIX A: BABAR 3

Appendix A: BaBar

Appendix A: BaBar and WIRED 4

BaBar geometry is included in a separate plugin under the name WIRED 3 Graphics Format. If this
plugin is loaded, any BaBar event will automatically also show the BaBar geometry.

BaBar events are made accessible via a CORBA server. To see these events you need the WIRED
CORBA HepRep Client Plugin installed, see the installation inctructions.

To select a CORBA server of BaBar, choose Open Data Source... from the File menu and select the
HepRep CORBA Servers wizard and click on Next.

You are now connected to a tree of servers, which will initially only show you the folder HepRep
CORBA Setvers at SLAC. Open this folder and the next one which says BaBar WIRED JProcMan. A
list of servers will now show. As you select one of them, the description field will change, explaining what
this server contains. Servers which show up in italics may have a problem. The description field will tell
you their status. You can now select the server you want and click on Finish. Your data source is now
open for browsing,.
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If you wish to connect to a server which is not in the list, for instance your own server, you can paste the
IOR into the IOR or URL field and click Add to List. You may give it a different name than New
Node of course. New servers are added to the top-level, and only visible to you. You can then select the
new server, see its status/description and click Finish to open the dataset for browsing.

-~ (pen Data Source... - § x|

/groups/ SP/0101/ 8800/ M10.
/ogroups/SP/0102/4100/M10.
Sgroups/ SPA0OL04/2 100/ M10.
Sgroups/ SPA0104/ 2300/ M10.
Jgroups/ SP/0104/8100/ M10.
/groups/ SP/0104/ 8300/ M10.
Sgroups/SPA0106/ 3200/ M10.
fgroups/ SPA0107/0500/M10,
Sgroups/SPS01107 15007 M10.
Sgroups/SP/0110/ 5400/ M10.
Sgroups/SP/0110/ 5800/ M10.
Sgroups/ SPA0OL1Z 5500/ M10.

L1aVD1xZ7F-R10.3.1aV01/010186874/al levencs 1491 =
L1aVD1xZ7F=-R10.3.1avV01/01024141/allevents 2000
.1aVD1x258F-R10.3.1aV01/01042188/allevents 1652
.1aV01x25F-R10.3.1aV01,/0104235%7/allevents 1074
.1aV01xZ5F-R10.3.1aV01,/01048126/allevencs 35
L1aVD1xZ8F=R10.3.1aV01/01048344/allevents S01
1aV01x29F-R10.3. 1aV01/01063272/allevents 1172
L1aViolxZ9F-R10.3.1aV01/01070551/allevents 1867
L1eV0Zx30F-R10.3.1cV02/01101584/allevents 1822
3
3
3
3
3

L1eVD1x30F=-R10.3.1eV01/01105483 /mllevents S60
L1eV01x30F=R10.3.1cV01/011055811/allevents 783
LAcVDEx31F-R10.3. 1cV02/01125560/allevents 1781
Sogroups/SPS0113/2900/M10. 3. 1cV01x31F-R10.3 . 1cV01/01132941/al levents 1144
Sogroups/SP/0113/ 6400/ M10.3. 16V01x31F-R10.3.1eV01/01136417/allevents 374
Sgroups/SP/0113/ 6900/ M10.3.1cV01x31F-R10.3.1eVD1/01136938/allevents 531

W L b W W W L W W W W Ly W W

Sgroups/S5P/0116/5400/M10.3 . 1dV01x32F-R10.3. 1dV01/01165497/allevents 1031 ;I
" Event List File

| Browse. .. |
" Ewent

[.-"?ftlrE.-"PE?kil'ﬂ?r'FH 414 4. 2a/80E vent s/ 03/AIE verds (365 1

Instead of clicking on Finish, you may select Next, which allows you to use a prepared event list. You
will see a default event in the Event box at the bottom. This default event is suggested by the server. If
you click on Finish now, it will be no different than if you clicked on Finish in the previous window.
However, you can also use your own event list, by pasting the full list into the EventList box at the top,
or by giving the filename of the Event List File box in the center. When you click Finish, make sure the
correct box is selected.

The BaBar event ID consist of three parts, though the first two are enough to identify the event:

Col | ecti onNanme Ordi nal Nunber Hexl| D

¢ The CollectionName refers to the name of a collection.

* The HexID (referred to within BaBar as the real EventID) is the most persistent form of event id. It
encodes the time that the event was detected by the BaBar online. A given event may then appear in
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one or more event collections (a raw form of the event, a later reconstruction collection, a
re-reconstruction collection, and so forth). Thus to uniquely identify a particular reconstruction
version of an event, one needs both the CollectionName and the HexID.

* The OrdinalNumber is just the ordinal position at which this event appears in the given collection.
Thus the event from some particular collision may appear as ordinal number 505 in one collection,
ordinal number 101 in some more refined collection, etc.

You can use the following in an event list:

* CollectionNane Ordinal Number: The fastest way, since the database allows random access by this
method.

* CollectionNane Hexl D: Slower in practice, since the WIRED server has to actually start at the head of
the collection and read through the tag part of every event until it finds a match for this HexID.
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Appendix B: GLAST

Appendix B: GLAST and WIRED 4

GLAST events can be accessed using from HepRep XML files or from a GAUDI server, which includes
a HepEventServer. To access this HepEventServer select Open Data Source... from the File menu and
select the HepRep CORBA Servers wizard.

Open Data Source...

HepHep CLHBS Sapeears

HepRep XML [ heprep.2ip. heprep.gz. .heprep.umi. heprep, heprepl. hep
P Hibook File: [.hbook, _pas]

Fioct D aaman

Rood File [Lrood)

4 | ¥

Cancel I Hel I €< Erevious I Heat 35 Emish
]
~CORBA Server

#- | HepRlep CORBA Servers ot SLAC
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Paste the IOR from your HepEventServer in the IOR or URL field and click Add to List. You may give
it a different name than New Node of course. New servers are added to the top-level, and only visible to
you. You can then select the new server, see its status/description and click Finish to open the dataset
for browsing.
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115 Appendix C: Linear Collider

Appendix C: Linear Collider and WIRED 4

LCIO files can be read and converted into HepRep 2 data by installing either the LCIO plugin or the
org.lcsim plugin.

The LCIO plugin is available in the Plugin Manager of JAS 3 under hep/linearcollider/lIcio.
The org.lcsim is available in the Plugin Manager of JAS 3 under hep/linearcollider.

Once either is installed, LCIO files can be opened and browsed, just like HepRep XML files. If you
install both JAS will ask you to choose the plugin to use when opening the files.
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Appendix D: GEANT4

Appendix D: GEANT4 and WIRED 4

From GEANT#4 [§] you can produce HepRepl or HepRep2 XML files. The standard GEANT4
distribution comes with a visualization driver for HepReps.

To select the HepRep2 driver you need to issue the following commands from the GEANT4 command
line:

/vislscenel/ create fil enane. heprep.zip
/ vi s/ open HepRepXM.

This will open a file with name filename.heprep.zip and put multiple events in it. To store events (and
geometry) in this file, you should issue a run command:

/ run/ beanOn 20

which will write 20 events and geometry.

To only write a geometry:

/vis/viewer/flush

More information on the HepRep drivers can be found in the README in the
stc/visualization/HepRep directory of the Geant4 distribution.
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Appendix E: History

Appendix E: History of WIRED

WIRED which stands for World-Wide Web Interactive Remote Event Display was initially developed in
1996 at CERN as an Applet to show the usefulness of the Java language in High Energy Physics. The
applet showed the DELPHI detector of LEP and was presented at the HepVis 1996 workshop at CERN.

The core of the Applet was rewritten for WIRED 1 which was adopted by the CHORUS and DELPHI
experiments for further event display usage. This version was presented at CHEP'97 in Betlin, Germany.

As research and development at CERN continued for the ATLAS experiment, WIRED 2 was developed
to cope with large events and special projections. Some of the work of WIRED 2 was generalized and
moved into the Java FreeHEP Library on top of which WIRED 3 and WIRED 4 were built. The Atlantis
event display for ATLAS was built from the WIRED 2 prototype.

In the meantime WIRED 3 was created, based mainly on WIRED 1, to support the BaBar experiment at
SLAC, which became one of the main users of WIRED. An integration was started with JAS 2, which
resulted in a plugin module of WIRED 3 specific for the Linear Collider Study at SLAC. This version was
presented at CHEP'2000 in Padova, Italy.

WIRED 4 combines some of the work done in WIRED 2 with a lot of the functionality in WIRED 3.
WIRED 4 was presented at Computing in High Energy Physics, CHEP2004, in Interlaken, Switzerland.
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5. JProcMan:
a Java-Based Process Management System, http://www.slac.stanford.edu/~petl/jprocman/

6. The FreeHEP Java Library,
http://java.frechep.org

7. WIRED 1, 2 and 3,
http://wired4.freehep.org/OlderVersions.html

8. The Geant4 Simulation ToolKit,
http://cern.ch/geant4
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